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Introduction 
The Sales Order Workbench is comprised of two modules; Sales Order Entry and Order Fulfillment. The 
Sales Order Entry function allows you to create and modify customer orders, and the Order Fulfillment 
process is used to commit inventory to orders, and release orders for shipment. 

The Sales Order Workbench is a Windows desktop application providing a graphical user interface, with 
the ability to read and update the Manfact database in real time. NorthClark Desktop Applications use a 
spreadsheet style interface with familiar editing tools such as copy, paste, and word wrapping.  Users 
may rearrange the column order, and hide unwanted columns.  All spreadsheet views may be printed or 
exported to Microsoft Excel. 

This screen is displayed when the Sales Order Workbench application is launched. 

 

The features available to each user will vary according to their Security settings. People who do not have 
Sales Order Entry or Shipping privileges may be authorized to use the application for inquiry purposes. 
Please refer to the System Administration section for more information. 
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Sales Order Entry 
The Sales Order Entry module includes the ability to: 

• Locate a list of Sales Orders using a variety of search criteria 

• Open a specific Sales Order or scroll through a list of Sales Orders 

• Create new orders and modify existing orders 

• Import new order information from a Spreadsheet 

• Cancel a Sales Order 

• View Available to Promise (ATP) information 

• View / Update Sales Order Text records (Note Numbers) 

 

Sales Order Search Results 
From this screen you may search for an existing Sales Order, enter a specific Sales Order Number, or 
start a new order. 

 

When you click the [SO Search] button at the bottom of the screen, a dialog is displayed allowing you to 
enter various search criteria. Please refer to the Tools section for more information on the Sales Order 
Search feature. 
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There are three ways to open a Sales Order: 1) Enter the Sales Order Number in the box at the top of the 
screen, 2) Double-click the row header next to the desired item on the results list, or 3) highlight the 
desired row and then click the [Open] button at the bottom of the screen. 

To begin entering a new Sales Order, click the [New Order] button at the bottom of the screen, or the 
first button on the toolbar at the top of the screen. If your company uses system assigned Sales Order 
Numbers, the message “(New)” will be displayed in the SO# box, and an identifier will be assigned 
when the record is saved. If you normally assign Sales Order Numbers manually, you will be prompted 
to enter the Sales Order Number at this time. 

Columns Displayed: 

Sales Order # Sales Order ID Number 

Cust # Customer Identifier  

Customer Name Customer Name 

Customer PO # Customer PO Number 

Status Current Sales Order Status  

    Not Ready:    Fill % is below Goal Fill % and not yet released. 
    Ready:           Fill % is equal or greater than Goal Fill % but not yet released. 
    Released:       Sales Order has been released for shipment. 

Order Total Total value of the Sales Order 

Warehouse Ship From Warehouse Identifier 

Last Ship Date Last Actual Ship Date 

Next Ship Date Next Scheduled Ship Date 
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Sales Order Entry – Header 
Use this screen to enter information that pertains to the entire Sales Order, including Customer and 
Shipping information. 

 

The navigator bar on the upper right corner of the screen allows you to scroll through a list of Sales 
Orders you have previously located using the Sales Order Search feature. 

Click the [Save] button to post your changes to Manfact, leaving the current record visible on your 
screen. Use the [Save + New] button to commit your changes, and then immediately clear the screen in 
preparation for entering a new order. 

The status bar at the bottom of the screen shows the current Order Value, Customer Name and Number, 
and the name of the Manfact account where you are connected. 

Prompts on this Screen: 

SO Date Sales Order Entry Date 

Quote# Sales Order Quote Number 

Sold-To Sold-To Customer Identifier 
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Name Sold-To Customer Name 

Cust PO # Customer Purchase Order Number 

Telephone # Customer Telephone Number 

Buyer Customer Buyer Name 

Priority Priority as established in the Customer file or updated from the search record. 

Ship Tol % Allocation Shipping Tolerance 

EDI Const Constant Code used for Electronic Data Interchange (Display Only) 

DD250 Flag indicating whether or not this order requires DD250 paperwork. Note, this 
application does not currently support entry of DD250 information. Please use SO.N 
for this purpose. 

Inspect Special Inspection Required? 

Print SO Check this box to print the Sales Order during the next run of SO.SET. 

Hold Hold Code - Check all that apply: 

    A    Accounting Hold 
    C    Credit Hold 
    E    Engineering Hold 
    M    Manufacturing Hold 
    S    Sales Hold 
    X    Matrix Hold 

Freight Tag Freight Payment Terms 

    P    Prepaid 
    C    Collect 
    A    Prepaid and Added to invoice in INV.SET 

FOB Point Free on Board Point – the location where ownership changes hands 

Routing Special Routing Instructions 

Ship Via Recommended shipping carrier 

Ship Name Ship-To Name 

Ship Address Ship-To Address 

Regions Sales Regions determine which shipping locations are valid for this order. 
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Prime Warehouse Primary Warehouse 

Sales Reps A list of Sales Representatives and the percent of the order for which each one will 
receive credit. 

Note Numbers Use the browse button next to this prompt to select text to be printed on the Sales 
Order, or enter a list of Note Numbers separated by commas. 

Notes Free Form Notes 

 

Sales Order Entry – Accounting 
Use this screen to enter information that pertains to the entire Sales Order, including Billing, Project, 
Contract and Tax information. 

 

Prompts on this Screen: 

Bill-To Bill-To Customer Identifier 

Name Bill-To Customer Name 
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Terms Select the appropriate payment terms from the drop-down list.  

Resale# Customer’s Resale Number for Sales Tax purposes. 

Project# Enter a Project Number if applicable. This value may be changed per line item. 

Contract# Enter a Contract Number if applicable. This value may be changed per line item. 

Retain Percent If applicable, enter the percentage of this invoice to be retained. 

Retain Terms Select the Terms Code to be used on the retention invoice. 

Geocode Identifier used by the Vertex Sales Tax software (display only). 

State Tax Code State Tax Authority as defined using Manfact’s SALESTAX.N procedure. 

Local Tax Code Local Tax Authority as defined using Manfact’s SALESTAX.N procedure. 

Other Tax Code Other Tax Authority as defined using Manfact’s SALESTAX.N procedure. 

Currency Code Code used to identify the currency for the country in which this customer resides. 

Date to Use Date to use for foreign currency calculation: Sales Order, Shipment or Invoice Date. 

Exchange Rate The exchange rate to be used for foreign currency calculation. 

Inv Sets Number of copies of the Invoice to be printed by INV.SET. 

Invoice Method Automatic or Manual 

Revenue Method At Shipment or Percent Complete 

Percent Complete This value is used to calculate earned revenue when the Percent Complete Revenue 
Method is chosen. (Display only) 

Order Value Total extended price of all line items on this order. (Display only) 

Revenue Taken Sales revenue recognized to date. (Display only) 

Shipped Value Total value of shipments to date. (Display only) 

Sales Invoiced Total Sales Amount invoiced to date. (Display only) 

Other Invoiced Total Freight, Tax and Misc. Charges invoiced to date. (Display only) 

Total Invoiced Total value of all invoices to date. (Display only) 

 

7 



NorthClark Computing, Inc. 

Sales Order Entry – Line Items 
Enter one row for each unique item to be shipped on this order. You may type the information, or import 
it from an Excel spreadsheet. 

 

 

Column Definitions: 

Li # Sales Order Line Item Number 

Quote # Quote Number 

Quote Li # Quote Line Item Number 

Order Type Sales Order Type 

Assoc Li # Used to form an association between material lines and non-inventory charge lines 
on a sales order. 

Ref Part Number Cross Reference Part Number used to convert non-Manfact part number to Manfact 
Part Number. 

Model/Part Number Manfact Part Number or Lot Priced Item. Note, if using the Model Configuration 
System, you must configure the Model using Manfact’s MOD.Q procedure prior to 
entering the Sales Order. 

Description Model or Part Number Description 
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Schedule Double-click on this cell to update multiple Schedule Dates, Quantities, Request 
Dates, and Reason Codes. 

Order Qty Line Item Total Order Quantity 

Unit Price Unit Selling Price 

Price Conv Factor Used when the unit "PRICE" is per a unit of measure other than the selling unit of 
measure. 

Price Per Factor Unit price for this line item will be multiplied by the total quantity and then divided 
by this factor. 

Disc Pcts Discount Percentages (may be multiple) 

Disc. Amt Discount Amount 

Ext. Amt Extended Line Item Amount (Display Only) 

Foreign Price Foreign Unit Selling Price 

Foreign Disc Foreign Discount Amount 

Commissions Line Item Commission Rate and Rep Number. Double-click on this cell if you need 
to change the commission rates. 

NSN National Stock Number 

Project # Project Number 

Contract # Customer Contract Number 

Rev. Revision Level Number 

Tax Type Line Item Tax Type Code defined in TABLE.TAX. 

Hold Hold Code 

    A    Accounting Hold 
    C    Credit Hold 
    E    Engineering Hold 
    M    Manufacturing Hold 
    S    Sales Hold 
    X    Matrix Hold 

Notes Free Form Notes. Double-click to pop-up a text editing window. 
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Change Notes Information that will be added to the Sales Order Change file record. Double-click to 
pop-up a text editing window. 

WO Notes Work Order Notes. Double-click to pop-up a text editing window. 

Note Numbers Used to retrieve notes from the SOTEXT file. 

Allocated Qty Quantity currently allocated for shipment (Display Only) 

Shipped Qty Quantity shipped to date (Display Only) 

Cancel Qty Quantity cancelled, date and reason code. Double-click to edit. 

 

Sales Order Text (Note Numbers) 
Use this screen to view and/or edit Sales Order Text records. The features available will depend on your 
Security privileges. Please refer to the System Administration section for more information. 

 

If you are adding notes to an order, use the checkboxes in the first column to select the desired notes, 
and then click the [Select] button. 

If you modify and then save changes to the text, the information will be permanently changed for all 
Sales Orders that reference the affected Note Number. 
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Cancel a Sales Order 
You may cancel the remaining balance for the entire Sales Order by selecting the Cancel Sales Order 
option from the Tools menu, or double-click on the Schedule column to reduce the quantity on a specific 
line item. Whenever the quantity is reduced on an existing Sales Order, the following dialog is 
displayed. 

 

You cannot reduce the Schedule Quantity below the quantity currently Allocated or Shipped. 
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Order Fulfillment 
The Order Fulfillment module includes a number of special features that will be of particular interest to 
organizations that ship a large volume of sales order line items per day.  Their products may be shipped 
to large retail stores and backorders may not be accepted.  So, if an order is shipped at less than 100% 
complete, the remainder of the order is cancelled and the sale is lost.  When prioritizing orders for 
shipment it is not only important to ship on schedule, but the planner must also take steps to maximize 
the order fulfillment rate. 

This application will be used to provide tools to assist the planner in scheduling shipments for the next 
business day.  The Sales Order Fulfillment module is designed to accomplish four primary objectives: 

• "Reserve" current on-hand inventory to orders 

• Allow the planner to adjust inventory reservations as necessary to maximize fulfillment rates. 

• Provide visibility to inventory that is expected to be available based on MRP planned orders and 
scheduled receipts. 

• Automatically Release an order when the desired fulfillment percentage is reached or set at the 
user's discretion. 
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Workflow Display 
The Workflow view provides immediate visibility to tasks requiring the Planner's attention, and may be 
used to navigate to each item.  Click on a Workflow item to view the corresponding list of Sales Orders 
shown on the “Search Results” tab.  As an alternative, you may click the [SO Search] button to locate 
Sales Order using a variety of search criteria. Please review to the Tools section of this document for 
more information about the Sales Order Search feature. 

 
 

The Plant, Warehouse, Sales Rep, Customer, and Priority Range prompts may be used to limit the orders 
included in your Workflow Counts. 

Check the “Hide Rows With Zero Counts” to view only those rows where the Workflow Count is 
greater than zero. 

Workflow Counts are automatically refreshed at the time interval entered in the Workflow Options 
screen (accessed from the Tools menu).  You may update the counts on demand by clicking the 
[Refresh] button. 

Now that the correct criteria has been selected, click on the “View Details” button for the orders you 
wish to review.   
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The tasks that are accessible from the Workflow screen include. 

Released Orders Awaiting Shipment Sales Orders that have been released but not yet shipped. 

SO’s Fully Reserved, Not Released Sales Orders that have been fully reserved but not yet 
released. 

SO’s Above Minimum Fill%, Not Released Sales Orders above the minimum Fill % but released. 

SO’s Below Minimum Fill% Sales Orders below the minimum Fill % 

Past Due Orders Past Due Sales Orders 

Sales Orders on Hold Sales Orders that are on Hold 

    A    Accounting Hold 
    C    Credit Hold 
    E    Engineering Hold 
    M    Manufacturing Hold 
    S    Sales Hold 
    X    Matrix Hold 
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Workflow Options 
Workflow Options allow each user to set their own preferences for when the Workflow update process 
is run. This view is accessed from the Tools menu of the Order Fulfillment screen. 

 

 

 

Select from the following options: 

• Update Workflow Counts When Program Starts:  Each time you start a new session the system 
will automatically update the Workflow Counts. 

• Enable Automatic Workflow Updates:  You can establish time intervals to automatically update 
the Workflow Counts. 

• You can also enable the system to Play a Sound When New Works Arrives. 

You may also update the Workflow Counts anytime by clicking on the Refresh button on the Workflow 
view. 
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Search Results – Release Order for Shipment 
This view displays a list of Sales Orders based on the criteria entered on either the Workflow or Sales 
Order Search view.  From the Search Results tab, you may modify the Priority, Ship Method, and 
Release Status of each Sales Order.  Double-clicking on a row transfers control to the Sales Order Detail 
(Header) view. 

 

Right-clicking on the spreadsheet displays a pop-up menu as shown below: 

 

Selecting the last item displays the Inventory Reservation Detail screen for the selected Sales Order.  
See Inventory Reservations Detail Screen section for more details. 

Use the [Auto Reserve This List] button to automatically process Reservations for all orders on this list.  
Please refer to Batch Inventory Reservation Process section for more details. 

Use the [Release All] button to automatically Release all orders on this list. 

Use the [Release None] button to remove any Sales Order selected for Release. 
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Column Definitions: 

Release Now Check the box if you wish to release this order now 

Force Release Release the order, regardless of inventory availability 

Priority Priority as established in the Customer record 

Ship Method Shipping Method options are defined in System Administration 

 

The remaining columns are for display only, and may not be changed: 

Warehouse Ship From Warehouse ID 

Sales Order # Sales Order ID Number 

Hold Flag indicating the Sales Order is on Hold. 

Cust # Customer Identifier (Code or Number) 

Customer Name Customer Name 

Customer PO # Customer PO Number 

Next Ship Date Next Scheduled Ship Date 

Last Ship Date Last Actual Ship Date 

Order Total Total value of the Sales Order 

Fill % (Qty) Actual Fill % (Qty) based on current Inventory Reservations. 

Fill % (Cost) Actual Fill % (Cost) based on current Inventory Reservations. 

Fill % (Goal) Fill percent that must be reached before an order can be automatically released. 

Status Current Sales Order Status  

    Not Ready    Fill % is below Goal Fill % and not yet released. 
    Ready           Fill % is equal or greater than Goal Fill % but not yet released. 
    Released       Released Sales Order 

Fill Policy Value that defines how orders for this customer will be handled by the Batch 
Reservation Process: 

In Priority Sequence they are: Diamond, Platinum and Gold 
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Sales Order Detail View (Header) 
This view displays header of the Sales Orders contained in the Search Results tab.  Sales Orders are 
displayed one at a time.  You may toggle to any of the Sales Orders by using the Navigation Bar at the 
bottom of the screen. 

 
All fields on this screen are for display only and may not be changed using this procedure. 

Field Definitions: 

SO Date Sales Order Entry Date 

Sold-To Sold-To Customer ID (Code or Number) 

Name Customer Name 

Cust PO # Customer Purchase Order Number 

Telephone # Customer Telephone Number 

Buyer Customer Buyer Name 

Inspect Special Inspection Required? 

DD250 Flag indicating whether or not this order requires DD250 paperwork. 
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Priority Priority as established in the Customer file or updated from the search record. 

Hold Hold Code 

    A    Accounting Hold 
    C    Credit Hold 
    E    Engineering Hold 
    M    Manufacturing Hold 
    S    Sales Hold 
    X    Matrix Hold 

Region Sales Region 

Prime Whse Primary Warehouse 

Freight Tag Freight Payment Terms 

    P    Prepaid 
    C    Collect 
    A    Prepaid and Added to invoice in INV.SET 

FOB Point Freight on Board Point 

Routing Special Routing Instructions 

Ship Via Recommended Ship Via Method 

Ship Name Ship To Name 

Ship Addr Ship To Address 

Order Fill Actual Fill % 

Target Fill Goal Fill % 

Ship Tol % Allocation Shipping Tolerance 

Last Ship Last Actual Ship Date 

Next Ship Next Scheduled Ship Date 

Status Current Sales Order Status  

    Not Ready    Fill % is below Goal Fill % and not yet released. 
    Ready           Fill % is equal or greater than Goal Fill % but not yet released. 
    Released       Sales Order has been released for Shipment 

Notes Free Form Notes 
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Sales Order Detail View (Line Items) 
This displays the Line Item view of the Sales Orders contained in the Search Results tab.  Sales Orders 
are displayed one at a time.   

 

All fields on this screen are for display only and may not be changed using this procedure. 

Li # Sales Order Line Item Number 

Quote # Quote Number 

Quote Li # Quote Line Item Number 

Order Type Sales Order Type 

Assoc Li # Used to form an association between material lines and non-inventory charge lines 
on a sales order. 

Ref Part Number Cross Reference Part Number used to convert non-Manfact part number to Manfact 
Part Number. 

Model/Part 
Number 

Manfact Model or Part Number 

Description Model or Part Number Description 

Schedule Line Item Schedule Date * Quantity 

Order Qty Line Item Total Order Quantity 
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Unit Price Unit Selling Price 

Foreign Price Foreign Unit Selling Price 

Price Conv 
Factor 

Used when the unit "PRICE" is per a unit of measure other than the selling unit of 
measure. 

Price Per Factor Unit price for this line item will be multiplied by the total quantity and then divided 
by this factor. 

Disc Pcts Discount Percent 

Disc. Amt Discount Amount 

Foreign Disc Foreign Discount Amount 

Commissions Line Item Commission Rate and Rep Number 

Project # Project Number 

Contract # Customer Contract Number 

Rev. Revision Level Number 

Tax Type Line Item Tax Type Code defined in TABLE.TAX. 

Hold Hold Code 

    A    Accounting Hold 
    C    Credit Hold 
    E    Engineering Hold 
    M    Manufacturing Hold 
    S    Sales Hold 
    X    Matrix Hold 

Notes Free Form Notes 

Change Notes Information that was added to the Sales Order Change file record. 

WO Notes Work Order Notes 

Note Numbers Used to retrieve notes from the SOTEXT file. 
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Right-clicking on the spreadsheet displays a pop-up menu as shown below: 

 

The options displayed on this menu allow you to branch to the Inventory Reservation Detail screen or 
the Available to Promise inquiry for the selected Sales Order or Part Number.  See Inventory 
Reservations Detail Screen and Available to Promise sections for more details. 
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Customer Order Policy Update 
This view allows you to enter search criteria for selecting customers to be view and update the Priority, 
Fill Percent and Fill Policy. 

 
You can use the available search fields in any combination to narrow your search.  If you don’t know the 
specific details of a particular field, you might use wildcarding to enter only a portion of the part 
number, project number, etc.  Please refer to the General Information section of this document for more 
information on wildcarding. 

This view will allow the user to enter/modify the default Priority Level for customers, along with their 
required Fill Percentage and Order Fulfillment Policy.   

Note, the Shipping Policy information may be different for each Plant/Company.  The prompt at the top 
right of the screen allows the user to select the Plant to update.  If the Shipping Policy is the same for all 
Plants/Company, select (All) from the drop-down list. 

The only fields that may be modified on this screen are Priority, Fill Percent, and Fill Policy.  All other 
Sales Order fields are for display only. 
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Priority Used for sorting orders during Batch Reservation Processing. 

Fill Percent The Fill Percent that must be reached before an order can be automatically released for 
shipping. 

Fill Policy Defines how the Batch Reservation Process will handle orders for the customer. 

Diamond: Normally used for the most important customers.  The system Reserves 
everything that is available, and backorders the balance. Once material is reserved, the 
system will never automatically remove the reservation.  Changes must be made in the 
Inventory Reservation process. 

Platinum: The system reserves everything that is available, and then checks the fill 
percent.  If the order does not meet the specified minimum, all parts are placed in 
Backorder status, making the parts on-hand unavailable for any other orders during this 
run.  All  backorders will be removed and reanalyzed during the next run of the Batch 
Reservation Process. 

Gold: The system reserves everything that is available, and then checks the fill percent.  If 
the order does not meet the specified minimum, all parts are placed in Future status, 
making the parts available to reserve to other orders. 

In all cases, once the required Fill Percent is reached, the order will be automatically 
released for shipping. 

Customer # Customer ID (Code or Number) 

Customer 
Name 

Customer Name 

Address Customer Address 

City Customer City 

State Customer State 

Zip Customer Zip 

Phone # Customer Phone Number 

Fax # Customer Fax Number 

Whse Primary Warehouse to Ship From 

Rep Primary Sales Representative assigned to the Customer 
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Batch Inventory Reservation Process / Releasing the Order 
Select the Batch Inventory Reservation Process from the Activities Menu or execute the procedure from 
the Search Results view.  This process will automatically reserve available material to open Sales 
Orders, and optionally release orders where fill percentage requirements have been met (See System 
Administration).  Orders are selected that have a balance to ship, and have not already been released. 

Only one user may execute this procedure at a time.  While it is running, all Inventory Reservation 
features in this application will be “locked”.  The following message is displayed when this option is 
selected from the Activities menu: 

 

The process begins by removing all backorders.  All existing reservations are then verified to ensure the 
reserved quantities and lot numbers are still in inventory.  If the quantities are not valid (e.g., because the 
lot was shipped on another order), the system will remove the invalid reservation, and then attempt to 
reserve the required quantity from the current available inventory.  Any quantity that cannot be 
successfully reserved will be placed in either backorder status. 

Next, orders are selected according to the option chosen in the System Administration screen (by 
Priority Level and Schedule Date, or by Schedule Date and Priority) and the system attempts to reserve 
material based on current available inventory.  It will then attempt to release orders according to the 
Order Fill Policy assigned to the Customer.  Please refer to the System Administration section for 
additional parameters that affect this process. 

Releasing an Order 
A checkbox on the System Administration screen enables the Automatic Order Release feature of the 
Batch Reservation process.  Anytime an order is Released, whether from the Main screen, the Inventory 
Reservation Detail screen, or in Batch mode, all Reserved quantities are moved to Allocated status and a 
Shipment record is created.  If the option was chosen to Force Release Backorder Quantities, the system 
attempts to force allocate the order.  Any unallocated balances are moved to Future status. 

Auto-Release Time Fences 
The following parameters are set via the System Administration screen: 

• Time Fence (days) for Complete Shipments 

• Time Fence (days) for Partial Shipments 

25 



NorthClark Computing, Inc. 

If the order is fully Reserved, the first Time Fence is used.  If the order is not complete but has achieved 
the required Fill Percent, the second Time Fence is used.  The Latest date to Release is calculated by 
adding the appropriate Time Fence parameter to the Current Date.  If the Schedule Date on the order is 
greater than the Latest Date to Release, it will not be Released. 

Sales Orders may also have a “Do Not Ship Before Date”.  If this field is blank, it is ignored, otherwise 
the system will not release the order prior to this date. 

26 



NorthClark Computing, Inc. 

Inventory Reservations Detail Screen 
This view may be accessed by right-clicking on the Sales Order Summary (Search Results) view, the 
Sales Order Detail (Line Items) view, or by selecting it from the Activities menu. 

When this screen is accessed from the right-click menu on the Search Results or Line Items tab, the 
Sales Order Number or Part Number from the active row is passed automatically. 

Sales Order View 
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Part Number View 
 

 

When selected from the Activities menu, you must perform a Search to locate the desired Sales Order or 
Part Number.  You can restrict this search to Sales Orders Scheduled before a given date. 

You can perform all of the same Inventory Reservation updates whether you are viewing by Sales Order 
or by Part Number.  You will have the option to Release an Order for Shipment only when viewing by 
Sales Order.  The Force Back Order Quantities to Release option is available only when the user has the 
necessary security privileges.  Please refer to the Batch Reservation Processing section for more details 
about updates that occur when an order is released. 

You may access the Available to Promise view by right-clicking on a row. 

Automatic Reservation Processing 
Use the checkboxes displayed at the beginning of each row to select the items you wish to update, or use 
the buttons at the top-right to “Select All” or “Select None” of the rows for processing.   
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Next, choose the update you wish to perform from the list displayed: 

Reserve, then Back Order:  Reserves the available quantity then Back Orders the remainder 

Reserve, then Future:          Reserves the available quantity then moves the remainder to Future 

Back Order All:                   Back Orders the entire quantity 

Future All:                           Moves the entire quantity to Future 

 

Field Definitions: 

Sales Order Sales Order ID Number. 

Part Number Part Number.  If you do not know the part number, click on the icon to the right 
of the field to access the Part Number Search procedure. 

Customer/Part 
Description 

If you have entered a Sales Order Number, the procedure will display the 
customer name.  If you have entered a Part Number, the procedure will display 
the description of the part. 

Automatic 
Reservation 
Processing 

See Automatic Reservation Processing above. 

Part #/Cust # If you have entered a Sales Order Number, the procedure will display the Part 
Number.  If you have entered a Part Number, the procedure will display the 
Customer ID (Code or Name) 

Description/Customer 
Name 

If you have entered a Sales Order Number, the procedure will display the Part 
Number Description.  If you have entered a Part Number, the procedure will 
display the Customer name. 

Sched Date Scheduled Shipping Date 

Qty to Ship Quantity Scheduled to Ship 

Qty on Hand Current Qty on Hand 

Qty Avail Current Quantity Available to Reserve 

Reserved Current Reserved Quantity 

Back Order Current Back Order Quantity 

Future Qty Current Quantity in Future 
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Individual Updates 
You can modify the quantities in Reserved, Backorder, and Future status for each line item by typing 
directly into the spreadsheet.   

Note, the quantity Reserved may not exceed the Quantity Available. 

Saving Changes to Manfact 
Whether updating quantities manually or using the automatic option, none of your changes will take 
affect until you click the [Save] button.  In rare cases, inventory quantities may have changed, and the 
system may not be successful in processing a Reservation.  When this occurs, a warning message is 
displayed, the information on the screen is refreshed, and the user is given the opportunity to made 
additional changes as required. 
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Tools  
Available to Promise 
This screen combines MRP output (scheduled receipts and planned orders) with Inventory Reservation 
details to provide an Available to Promise forecast for a selected part number. 

 

On hand, Reserved, Back Order, and Future quantities are retrieved from the Manfact inventory files in 
real time.  Scheduled Receipts and MRP Planned Orders are obtained from the MRP requirements files, 
and are accurate as of the last time MRP was run. 

Although not illustrated in the example, demands from sources other than Sales Orders will also be 
obtained from the MRP requirements file.  This includes Work Orders, Transfers, and Independent 
Demand. 

MRP Planned Orders may optionally be excluded from the display via a setting on the System 
Administration screen. 

Note, Future orders are always sorted to the bottom, regardless of Schedule Date. 
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Field Definitions: 

Part Number Enter the Part Number. If you do not know the part number, click on the icon to 
the right of the field to access the Part Number Search procedure. 

Description Part Number Description 

On Hand Current On Hand Quantity 

Available Current Quantity Available for Reservation 

Part #/Cust # If you have entered a Sales Order Number, the procedure will display the Part 
Number.  If you have entered a Part Number, the procedure will display the 
Customer ID (Code or Name) 

Lead Time The time (in days) it normally takes to replenish stock from the date an order is 
placed. 

Safety Stock The minimum quantity of this part that should be retained as to assure a 
continuous supply of the part. 

Supply/Demand Supply: On Order and Planned Orders  

Demand: Reservations, Back Orders, Future Orders, Work Order Demand, 
Independent Demand. 

Type SO (Sales Order), PO (Purchase Order), WO (Work Order) 

Doc # Document ID Number 

Date Requirement Date or Supply Due Date 

Quantity Quantity of Supply or Demand 

Projected On Hand Calculated projected on hand inventory 
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Customer Search 
Use this option to locate both Sold-To and Bill-To Customer records in your Manfact system. This 
screen may be accessed from the Tools menu, or by clicking the browse […] buttons located next to the 
Customer Number prompts. 

 
 
You can narrow your search by using a combination of as many of these fields as necessary to minimize 
the number of records selected.  If you do not wish to use a particular search filter, simply leave it blank, 
or choose “All” from the drop-down list.  

If you don’t know the specific details of a particular field, you might use wildcarding to enter only a 
portion of the Customer Name, Phone Number, Zip Code, Rep, City or Type. 
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Part Number Search 
The Part Number Search query helps you locate a Manfact Part Number using a variety of search 
criteria.  This procedure is for inquiry purposes only, and does not allow records to be updated. 

 

The Part Number Search application is sold and installed separately. Please refer to the Part Number 
Search User Guide for more information. 
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Sales Order Search 
This view allows you to enter search criteria for selecting sales orders to be viewed or updated.  It is 
accessible from both the Sales Order Entry and Order Fulfillment modules. 

 
 
You can use the available search fields in any combination to narrow your search.  If you don’t know the 
specific details of a particular field, you might use wildcarding to enter only a portion of the part 
number, project number, etc.  Please refer to the General Information section of this document for more 
information on wildcarding. 

Click the [Search] button to begin searching the Manfact Sales Order file for the records that meet your 
criteria.  Use the [Clear Search] button to clear all text fields, and set all options to the default status as 
shown in the original example.  This leaves the screen in a state to select all open sales orders. 

Search Sets 
The Search Set commands at the bottom of the screen allow each user to name and save their favorite 
search options.  Select an existing Search Set from the drop-down list, or simply type a description to 
name a new Search Set. Click the Save button to save the settings for the named Search Set.  Click the 
Load button to recall the saved settings.  Click the Remove button to permanently delete the Search Set 
from the list. Check the Save Dates box if you want the system to remember dates when settings are 
saved.  If this box is unchecked, all date fields will default to the current date. 
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System Administration 
The System Administration view is accessed from the Tools menu, and is used to enter various 
parameters required to support the Sales Order Entry and Order Fulfillment processes. 

Order Fulfillment Parameters 
 

   

 

MRP Planning Group for ATP Default MRP Output Planning Group to be used for Available 
to Promise information. 

Include MRP Planned Orders in ATP Check the box if you wish to include Planned Orders in 
Available to Promise Calculations. 

Shipping Method User Defined Codes and Descriptions for your common 
shipping methods. 
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Default Fill Policy The Default Fill Policy.  See the discussion under Customer 
Order Policy Update for a description of the available Fill 
Policies. 

Default Fill Percent The Default Fill Percent that will be used if nothing has been 
entered in the Customer Order Policy. 

Default Priority Level The Default Priority Level that will be used if nothing has been 
entered in the Customer Order Policy. 

Auto Release Orders When Required 
Fill Percentages are Met 

If checked, the system will automatically release orders when 
the Fill Percentage is met.  See Batch Inventory Reservation 
Process and Releasing the Order for details on the process. 

Auto Release Time Fence(Days) for 
Complete Shipments 

The time in days when a fully reserved order will be 
automatically released.  The Latest Date to Release is 
calculated by adding the appropriate Time Fence parameter to 
the Current Date. 

Auto Release Time Fence(Days) for 
Partial Shipments 

The time in days when an order is not complete but has met the 
fill percent requirements will be automatically released.  The 
Latest Date to Release is calculated by adding the appropriate 
Time Fence parameter to the Current Date. 

By Priority, Then Schedule Date If checked, process orders by priority first, then by schedule 
date. 

By Schedule Date, Then Priority  If checked, process orders by schedule date first, then by 
priority. 

Based on Quantity Check if the automatic release processing will be based on fill 
percentage based on quantity. 

Based on Cost Check if the automatic release processing will be based on fill 
percentage based on cost. 
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Security 
Access to the Sales Order Workbench is controlled through standard Manfact Security procedures (i.e., 
SEC.N, SECMC.N).  The table below lists the entries that may be added to each user’s security table to 
enable various features. 

Note that certain privileges are granted based on your existing Manfact security settings. For example, to 
allow the user to create new Sales Orders, both NCC_SWB and SO.N must be added to their Manfact 
Security Table. 

NCC_SWB The application is available for query purposes only; no updates 
permitted. 

NCC_SWB + SHIP.N User can manipulate inventory reservations, and release orders for 
shipping. 

NCC_SWB + SO.N User can create and modify Sales Order records. 

NCC_SWB + SOTEXT.N User can create and modify Sales Order Text records.  
See additional instructions below. 

NCC_SWBADMIN Unrestricted access to all features of NCC_SWB, including System 
Administration, Sales Order Entry, and Order Fulfillment. 

 

Sales Order Text 
Access to Sales Order Text records is governed by Manfact’s TEXTCNTL.N and/or TEXTCNTL.A 
entry screens. The following prompts affect the behavior of NCC_SWB: 

1. Active: This prompt must be set to “Y” to enable the SOTEXT file, otherwise all Note Number 
prompts are disabled, and Sales Order Text records cannot be viewed or edited by anyone. 

2. Enable Text Delete: Set this prompt to “Y” to allow SOTEXT records to be deleted. Note, if the 
user does not have the ability to edit Sales Order Text, this prompt has no affect. If set to “N”, no 
one can delete SOTEXT records. 

3. App Proc Access? Set this prompt to “Y” to allow all users with SO.N privileges to update Sales 
Order Text. If set to “N”, only users with SOTEXT.N privileges may update the text. 
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General Information 
Printing a Spreadsheet 
Below is a sample of the screen that will appear when you select the Print option.  This will print the 
current active spreadsheet, so be sure to click on the spreadsheet you wish to print before choosing the 
Print option. 

 

Range - Selecting a Print Range  

You may choose to print the entire spreadsheet (all), selected cells (those that you have highlighted 
on the current screen), the current page (only the rows that are currently visible on your screen), or a 
range of page numbers.  

Orientation - Portrait or Landscape  

You may print your report in portrait mode (normal) or landscape mode (sideways). Printing in 
landscape mode will allow you to fit more columns of information on your report.  

Margins - Report Margins  

You can make your report more attractive by setting the top, bottom, left, and right margins. Reduce 
the left and right margins if you need to fit more columns on the report.  
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Units - Inches or Centimeters?  

Are the margins you entered expressed in inches or centimeters?  

Page Order  

If your report is too wide, it may span multiple pages. When this occurs, do you want the report 
printed from top to bottom or left to right?  

What Do You Want to Print?  

You can customize the appearance of your report by printing (or not printing) column headers, row 
headers, grid lines, borders, shadow, and color.  

Headers and Footers  

Your report may have up to three lines for the heading, and one line for the footer. The system 
initially displays a default heading, which you may modify if desired.  

Tip: Use /p to designate a page number.  

Which Columns Do You Want to Print?  
The columns that are available for printing are listed. Select the columns you wish to include on your 
report.  
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Import a Spreadsheet 
This screen below is displayed when you choose the option to Import data from a Microsoft Excel 
spreadsheet, a tab-delimited text file, or a comma-separated text file. The data will be imported to the 
current active spreadsheet, so be sure to click on the desired spreadsheet before choosing this option. 

 

 

Import File Name:  Enter the path for the file that you wish to import.  You may browse the files by 
clicking on the button next to the text box. 

Worksheet Name:  Select the Worksheet Name from the drop-down list. 

Header Rows:  Enter the number of rows at the beginning of the file that are not to be imported 

Import File Type:  Select the type of file that you are importing 

Data Mapping:  Enter the Column Number or Letter where data resides on the Excel file.   
Import Data:  Click [Import] to begin the import procedure. 
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Exporting a Spreadsheet to Excel 
Below is a sample of the screen that will appear when you select the Export to Excel option.  This will 
export the current active spreadsheet, so be sure to click on the spreadsheet you wish to print before 
choosing the Export option. 

 
Save As File Name 

Enter the pathname of the file you wish to create.  You may Browse the files by clicking the button to 
locate the drive and folder where the file will be stored. 

Sheet Name 
Enter the Excel sheet name to create. This will automatically default to Sheet1. 

Export to Excel or to a File? 
You may export the contents of the display directly to Excel, or you may choose to create a file in 
Excel format. 

Create a Log File? 
Select this option to create a log file. The log file contains error messages and other information 
about how your Excel file was created. The name of the log file is "CreateExcelFile.log", and it will 
be stored in the same folder as your spreadsheet. 

Data Mapping 
You may move data to alternate columns by changing the column number or letter.  You may also 
remove a column by removing the row that contains the column information you do not wish to 
export. 

Export Button 
After all required information has been entered, click this button to export your data to Microsoft 
Excel. 
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 Arrange/Hide Columns 
Choose Arrange / Hide Columns to modify the sequence or display of columns. 

 

Hiding Columns 
To hide a column, remove the checkmark that appears under the column heading.  Click the OK button 
and when you return to the screen you will notice that the column no longer appears. 

To restore the hidden column either re-enter the checkmark under the column heading or select the 
Show Hidden Column option from the View Menu. 

To change the sequence of columns across the screen, highlight the column by clicking on the column 
field.  This will change the column color to blue, as shown in the example above.  Then select the 
appropriate button to move the column to the desired location. 

Reset to Default 
To return the screen to the original design, click Reset to Default to return columns to their original 
position. 

Freezing Columns and Rows 
You may freeze columns and/or rows so they are always visible.  To do this select the number of 
columns and/or rows you wish to freeze. 

Saving the changes 
Once you have made all the appropriate changes, click OK to implement these changes on your screen. 
Note, these settings are stored in the Windows Registry for each user. 
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Wildcarding 
Wildcarding is a powerful feature that allows you to search using a portion of the field. You tell the 
system you want to use a wildcard by typing three periods “…” or an asterisk “*” at the beginning or 
end of your search entry. Here are some examples of wildcard commands and their expected results: 

Part Number:  XTR… (or 
XTR*)  

Returns part numbers that begin with “XTR”  

Description: …VALVE… 
(or *VALVE*) 

Returns parts with the word “VALVE” 
anywhere in the description.  

Category: …A (or *A)  Returns parts with a category ending with the 
letter “A”.  

 

44 



 

 

 

ERP Consulting, Web Development,  

Custom Programming Solutions,  

Web & Desktop Applications for Manfact 

Oreg

Pho

Fa

Email:  
PO BOX 2096 

on City, OR  97045 

 

ne:  503.632.5671 

x:  503.632.5688 

 info@northclark.com


	Introduction
	Sales Order Entry
	Sales Order Search Results
	Sales Order Entry – Header
	Sales Order Entry – Accounting
	Sales Order Entry – Line Items
	Sales Order Text (Note Numbers)
	Cancel a Sales Order

	Order Fulfillment
	Workflow Display
	Search Results – Release Order for Shipment
	Sales Order Detail View (Header)
	Sales Order Detail View (Line Items)
	Customer Order Policy Update
	Batch Inventory Reservation Process / Releasing the Order
	Inventory Reservations Detail Screen

	Tools
	Available to Promise
	Customer Search
	Part Number Search
	Sales Order Search

	System Administration
	Order Fulfillment Parameters
	Security

	General Information
	Printing a Spreadsheet
	Import a Spreadsheet
	Exporting a Spreadsheet to Excel
	Arrange/Hide Columns
	Wildcarding



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /ENU (Use these settings to create PDF documents with higher image resolution for high quality pre-press printing. The PDF documents can be opened with Acrobat and Reader 5.0 and later. These settings require font embedding.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308030d730ea30d730ec30b9537052377528306e00200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /FRA <>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


